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Disclaimer

This manual and the information contained herein are the sole property of EVS Broadcast
Equipment SA and/or its affiliates (EVS) and are provided “as is” without any expressed or
implied warranties, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose. In particular, EVS makes no warranty regarding the
use or the consequences of use of this manual and the information contained herein.
Furthermore, EVS may not be held liable for any direct or indirect, incidental, punitive or
consequential loss, damage, cost or expense of any kind whatsoever and howsoever
resulting from the normal or abnormal use of this manual and the information contained
herein, even if advised of the possibility of such loss, damage, cost or expense.

While every effort has been made to ensure that the information contained in this manual
is accurate, up-to-date and reliable, EVS cannot be held liable for inaccuracies or errors
that may appear in this publication. The information in this manual is furnished for
informational purpose and use only and subject to change without notice.

This manual cancels and replaces any previous versions thereof.

Copyright

Copyright © 2009-2018 EVS Broadcast Equipment SA. All rights reserved.

This manual may not be reproduced, transcribed, stored (in a database or an retrieval
system), translated into any language, computer language, transmitted in any form or by
any means — electronically, mechanically, printed, photocopied, optically, manually or
otherwise —in whole or in part without the prior written consent of EVS.

Trademarks
All product and brand names are registered trademarks and trademarks of EVS or of their
respective owners.

Improvement Requests

Your comments will help us improve the quality of the user documentation. Please send
improvement requests, or report any error or inaccuracy on this user manual by e-mail to

doc@evs.com.

Regional Contacts

You will find the full list of addresses and phone numbers on the following webpage:
http://www.evs.com/contact.



mailto:doc@evs.com
https://www.evs.com/contact
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User Manuals on EVS Website

The latest version of the user manual, if any, and other user manuals on EVS products can
be found on the EVS download center, on the following webpage:
https://www.evs.com/en/download-area.
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What's New?

In the XNet Monitoruser manual, the icon has been added on the left margin to
highlight information on new and updated features.

The changes linked to new features and having an impact on the user manual in version
1.6 are listed below. The full list of new features is available in the release notes.

New fields "Interface"”, "HDR" in Server Details area, Status tab

»  See section "Audio-Video Area" on page 19.

New field "Hardware Edition History" in Server Details area, Hardware tab
» See section "Hardware Tab" on page 26

New tab "Temperature" in Server Details

» See section "Overview on the Server Details Area" on page 17

» See section "Temperature Tab" on page 28

What's New?
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1.

1.1.

1.2.

Introduction

Product Overview

XNet Monitor is a tool aimed at monitoring EVS products. It displays real time information
and status about the EVS video servers and other EVS products, as well as past alert and
warning messages.

XNet Monitor uses the SNMP (Simple Network Management Protocol) protocol to request
and receive monitoring data from the EVS servers. This internal status data is defined in
the MIB (Management Information Base) on each EVS server.

One XNet Monitor application can monitor several EVS servers and other EVS products
while one EVS server or product may also be monitored by several XNet Monitor
applications.

XNet Monitor is mainly a monitoring application that cannot act on the monitored servers.
Some remote actions are however possible: Multicam version upgrade, keyword file
maintenance, as well as remote access to an EVS server desktop, or to an LSM Remote
Panel.

NOTE

The full list of EVS products that can be monitored with XNet Monitor are
specified in the release notes. All currently supported EVS servers can be
monitored with XNet Monitor.

Installation

Requirements

*  PC compatible computer
»  Supported OS: Windows Server 2008 R2, Windows 7, Windows 10

* .Net framework 4.6 or higher installed

Recommendation

The SNMP information is available through the PC LAN connector of the server. The
computer running XNet Monitor should be connected to the same network, and not on any
of the Gigabit Ethernet ports of the servers. These ports are dedicated to high flow video
data and cannot be used for any other purpose.

1. Introduction
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1.3.

Upgrade and Downgrade

If an older version of XNet Monitor is already installed on your computer, it will be
automatically removed and replaced by the new one when you will install the new version
of XNet Monitor.

The XNet Monitor application must only be removed if you need to downgrade the
application. Removing the application can be done as usual, through Windows Control
Panel and Add or Remove Programs menu.

Accessing the Application

How to Open XNet Monitor

To open the XNet Monitor application, do one of the following actions:

|

—_—

*  Click the XNet Monitor icon on the desktop

»  Click the Windows icon and select EVS Broadcast Equipment > XNet Monitor.

1. Introduction
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1.4. User Interface Overview

Introduction

When you access XNet Monitor, the main window is displayed. The schema below
highlights the various areas on the main window.

OJ© ®

L1 xNet M4:rtnr - o x
File Tools Monitoring  Help |
=
Name SN Soft. Rev. State Genlock Jnalog LTC  Disk. PSU XNET Stalus ~ Traffic DB Stalus  Loc. Cips  Rem.Capacty  Temp. Ho  Temp. Hox
SRR 148 | 16.01.14 Vaidblackburt  Vabd | Unknown | Unknown  Unknown | Unknown | 00:00:00 0 0
B T Ruming | Vald blackburt | Vaid Unknown | Unknown | Unknown |Unknown |0 000000 o 1o
SR (302 160114 R o ok Vaild | Unknown | Unknown | Unknown | Unknown |0 00:00:00 0 0
ot 161160114 | Running | Vabd blackburst | Vald _‘OK[O!ﬁl Unkrniwn | Unknown Unknawn | Unknown | 20 28:40:00 [95%) |36
. o [150347 Vaidblackbust  Vald [OK(0sp) | Unknown | Unknown | Unknown |Unknown |15 1412605 [99%_|0 o
S 161 150048 Vaidbisckburst | Vabd | {Unknown | Unknown _ Unknown | Unknown |0 100:00:00 To 0
s (304 [160041 | Running | Vald blackburst__ Vald 1o»no:m 0K | Standakone _ Nomal Ok 17 105:39:11 16141 |0 o
. T30e (160103 N o blackb. . Unknown | OK (00 | Unknown | Unknown | Unknawn | Unknown |54 1154:3939 (92%1[0 1o
< >
Used Capacty:  15:2243
. [mercredi 7 novembre 2018 - : ~
— R Start Date: G ] Frer: [Not Acknowledged 1| Ak Aerts)
End Date: [mercred 7Tnovembee 2018 (v |
Name 1P Address Date Hert Messaqe ~
LWY-XT-Via 304840 |10.129.110.62 071118105931 | CAM A: Video Missing
LWY-XT-Via-304840 | 10.129.110.62 07-11-18 10:59:31 IPDP on RS 422 ##4 Disconnected
LWY-XT-Via 304840 |10.129.110.62 071118105931 Gbe Post2: operational status is Down
CDOXTO4SNIBI0T | 10129110104 071118105330 | Status:not ruming "
Waiting 234/300 sec | |
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Area Description

The table below describes the various parts of the XNet Monitor main window:

# Window area

Description

1.  Menu bar

2. Monitored Device tree

3.  Monitoring Data area

4. | Alert Information area

5. Disk Usage

6. Status bar

It gives access to various functions.
See section "Menu Bar" on page 5.

It displays the monitored devices in a user-defined tree
architecture.

See section "Description of the Monitored Device Tree"
on page 6.

It displays diferent data depending on what is selected in

the Monitored Device Tree:

» Detailed information on the selected EVS server.
The areais then called the Server Details area.
See section "Overview on the Server Details Area"
on page 17

» Detailed information when another EVS hardware is
selected.

The areais then called the Device Details area.
See section "Device Details" on page 29.

e Summary information on several devices when a
group of devices is selected.

The area is then called the Monitoring List area.
See section "Description of the Monitoring List" on
page 15

It allows users to display and acknowledge the alerts.
See section "Managing Alerts" on page 33

It displays a pie chart with the total used and remaining
disk space for the selected device.

It provides information about the monitoring status.

1. Introduction
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1.5. Menu Bar

General Description

The menu bar gives access to various functions. You will find below a short description of
the menu items.

Area Description

The following table presents the items on the menu bar:

Menu Description

File menu Allows you to manage the EVS servers and other EVS devices
stored in the Monitor Device tree.
See section "Managing the Monitored Device Tree" on page 12

Tools menu Gives access to the configuration tools and settings described
in these sections:
»  "Customizing the Monitoring List" on page 9
*  "Organizing Monitored Devices" on page 7
*  "SNMP and General Settings" on page 12
» "Trap Configuration" on page 10
Gives access to commands to manage Multicam versions and
keyword files on the EVS servers:
e "Multicam Upgrades" on page 45
* "Uploading a Keyword File on an EVS Server" on page 50

Monitoring menu Allows you to start or stop the monitoring on the EVS servers
and devices displayed in the Monitored Device Tree.
See section "Start Monitoring" on page 14

Help menu Gives access to the user manual and information about the
application.

1. Introduction 5
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2.

2.1.

2.2.

2.2.1.

Configuration

Network Settings

Introduction

Should you face issues to set up XNet Monitor in your network, and should a network
configuration be required, you will find the necessary network information in this section.

Description

Monitoring
*  Monitoring protocol :SNMP
»  Communication for the polling : TCP on port 161 (bidirectional)

»  Communication of the SNMP traps : UDP on port 162 (outbound out of the server
only)
Remote desktop and LSM Remote functions

+  TCP 50000 (bidirectional)
Config Web

*  Communication in HTTP on port 80 (bidirectional)

Monitoring Configuration

Description of the Monitored Device Tree

Introduction

The Monitoring Devices Tree displays the devices monitored on the network. They are
listed in a tree architecture independent of the network architecture as shown on the
screenshot below. The Monitoring list is defined by the user.

= . HMet [13]
= . Digcovered Hosts (13
ﬁ HTMHewd DL [4)
ﬁ #THewPGE [7]
‘ EPSIOADTER30
‘ 1.1.53.100171]
‘ IPLATB4130([1]

2. Configuration
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2.2.2.

XNet Node

The higher node is called XNet as it represents the EVS XNet proprietary network. Under
this first level node, you must add one or more groups. These groups are only virtual
groups used for easy organization and management of multiple servers.

Groups

The groups are defined by the user. The group definition is not tied to the network
architecture: this is only a virtual layout the user can organize freely. For easier
management, it is recommended to organize the groups based on physical localization of
the devices.

Hosts

The hosts are the monitored devices themselves. You can create them manually or
automatically as explained in See section "Organizing Monitored Devices" on page 7.

Status Summary

In the Monitored Device Tree, a colored bullet displayed next to the group or device
provides a summary of the device status, and has the following meaning:

» Ared bullet means that there is a warning and/or an error on a host.
» Agreen bullet means that everything is ok for that item.

The number between brackets next to an item indicates the number of pending SNMP
alert messages.

Organizing Monitored Devices

Introduction

To organize the monitored devices in the Monitoring List, you first have to create groups
under the XNet node. Then, you can add the monitored devices under the created groups,
either manually or automatically.

2. Configuration
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How to Add and Remove Groups

For an easy management, it is recommended to organize the groups based on physical
localization of servers.

To add a new group, proceed as follows:
1. Right-click on the XNet node and select Add group.
2. Enter arepresentative group name.

To remove a group, right-click on it and select Remove.

How to Add Devices Manually

To add individual devices manually, proceed as follows:
1. Right-click on a group and select Add host.
2. Enterthe device IP address in the Host Definition window.

You can also enter the hostname if it has been declared in a DNS server or in a host
file.

Host Definition

IP Address: 11201

Once the devices are entered in the list manually, you can organize them in the different
groups by drag-and—drop operation.

How to Add Devices Automatically

1. Open the Tools menu and select Discover.

The Discover SNMP Agents window opens

Discover SNMP Agents

IP Start: (172.16.0.1

Ping 172.16.0.4 Stop
| EEN

Discovery Results
Mo |IF Address Mame Type

8 2. Configuration
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2.2.3.

2. Inthis window, set the IP address range in which the program will look for available
devices.

3. Click the Start button to start the discovery process.

At the end of this process, the discovered devices will be listed in a new group called
Discovered Hosts.

Once the devices are entered through the discovery process, you can organize them in the
different groups by drag-and—drop operation.

NOTE

As this process is based on timeout for not used addresses, it may take some
time to parse along list.

How to Remove a Device

You can only remove a device when the monitoring is not started.

To remove a host, right-click on it and select the Remove command.

Customizing the Monitoring List

Introduction

When you select XNet or a group in the Monitored Device Tree, the Monitoring Data pane
displays the Monitoring List, which provides summary data about the servers available
under XNet or under the selected group.

You can specify which information should be displayed in the Monitoring List and how it
should be displayed via the Select Columns window.

How to Customize the Data

To customize the summary monitoring data, proceed as follows:

1. Inthe Monitoring Data pane, select the Organize Columns command from the Tools
menu.

2. Configuration
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2.3.

2.3.1.

2. The Select Columns window opens:

L] Select Columns — m} *
Available columns SelectedColumns
" ET- S ~
AV Channels SN
Base Corfig Soft. Rev.
Clip Capacity State
Clip Def. Copy Mode Genlock
Clip Edit By Network Analog LTC
Codec Config Insert Disk Up
Controller PSU
CPU Usage Remove XNET Status Down
Device Traffic
Disk Themal DB Status
Enclosure Type Loc. Clips
Fan HDX Rem. Capaciy
Gbe Port1 Default G Temp. Hix Board
Gbe Port1 [P Addres Temp. Ho CPU
Gbe Port1 Oper Stat ¥ Temp. Hex Memory

OK

3. Do one of the following actions:

o Toadd acolumn to the display, select it in the left Available columns list and
click on the Insert button.

o Toremove a column from the display, select it in the right Selected Columns list
and click on the Remove button.

o To change the columns order, select a column name in the right Selected
Columns list and move it up or down in the list using the Up and Down buttons
respectively.

4. Click on OK once the columns are organized as desired.

Trap Configuration

Description of the Trap Configuration
Window

Overview

You can access Trap Configuration window by selecting the Tools menu, and the Trap
Configuration command.

The Trap Configuration window displays the host tree (EVS servers or other EVS
hardware). For each host, the list of IP addresses of the computers registered to the host
toreceive its SNMP trap messages. Such a computer is called a trap target.

The trap targets can be computers that host the XNet Monitor application or a polling
service of XNet Monitor.

10
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The Trap Configuration window contains the areas or buttons highlighted on the

screenshot below:

Trap Configuration
Trap Corfiguration

'HnstName | LocallP !PAddrass1 IP&dd

d ... |10.36.014 8
10111180 17271615, 1036014 10.33.01 1036021 1031027 1031028 101111188
10111180 17271615, 1036014 10.33.01 1036021 1031027 1031028 101111188
17216165 1036018 1011111 1036021 1011111 103301 10111180 10.31.0.28
1011111 1721615, 1036014 10.33.01 1036021 1031027 1031028 101111149
1011110 1721615, 1036014 10.33.01 1036021 1031027 1031028 1001111149
1011110, 1721615, 1036014 10.33.01 1036021 1031027 1031028 1001111149
1011110, 1721615, 1036014 10.33.01 1036021 1031028 1001111 1000111154
1036021 1036018 1001111, 1036014 10111101, 1721615, 101111 101111198
1036021 1036078 1001111 1036014 1011111 1721605, 1071071 101111198
1001100 17271675, 1036014 10.33.01 1038021 1031027 1031028 100111149
1001100 17271675, 1036014 10.33.01 1038021 1031027 1031028 100111149
1001100 17271675, 1036014 10.33.01 1038021 1031027 1031028 100111149
10111110 1721615, 1036014 10.33.01 1036021 1031027 1031.028  1011.11.143 ¥

>

Master02 oK 011111 1036018
Master01 oK 011111 1036018
Nano TO1 oK 036014 10711111
ELM SED4 oK 0111141 1036018
ELM M&03 oK 0111141 1036018
ELM M&02 oK 0111141 1036018
X5 oK 0111141 1036018
Master02 036017 101111
Serverl = 036017 1071111
master oK 0111141 1036018
@SERVI 0K 0111141 1036018
serveil3 oK 0111141 1036018
Masterd oK 0111141 1036018
<

IP Address: | 10.11.11.143 v [ Remove ||

Add Local IP |

Idle

|

® ©®

Area Description

©

The table below describes the various parts of the Trap Configuration window:

Part Name

Description

1. Host tree

2. LocallP column

3. IP Addresses
columns

4. Add Local IP button

5 Remove button

6  Trap Registration
status bar

List of the monitored devices to which XNet Monitor
applications can be registered.

Trap status of the local IP address:
» Ifthe IP address is registered to receive the trap

messages, the cell will appear as 5

» Ifthe IP address is not registered to receive the trap
messages, the cell will appear as _

List of all IP addresses of computers (max. 10 per host)
registered as trap targets to the corresponding host.

Button that allows administrators to add the current
XNet Monitor IP Address on the monitored server.

Button that allows administrators to remove, in one go,
a trap target from all hosts it is registered to.

This button is used in combination with the drop-down
list on the left hand side, which allows the selection of
the trap target to be removed.

The status field and progress bar at the bottom of the
window display the currently executed command and
its progress status.

2. Configuration
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2.3.2.

2.4,

Managing the Monitored Device Tree

From the File menu, commands make it possible to manage the device and server list
available in the Monitored Device Tree. This list is saved as an .xml file for future use
and/or for transfer to another monitoring computer. This allows easy sharing and
management synchronization of servers and hosts tree organization.

The following commands are available in the File menu.

Parameter Description

New To create a new virtual architecture from scratch.

Open To open an existing architecture saved as an xml file.

Save To save the currently open architecture xml file.

Save As To save the currently open architecture xml file as a new file.
Exit To close and exit XNet Monitor

Introduction

Settings

# Local Clip Threshold:
Fem. Cap. Threshold:
SHMP Polling Period:
SHMP Time Out:

Enable Gigabit ICKMP Polling:

ICKP Time Out:
Enable Server Reboot:
Enable SHMP Loog:

Enable Server Explorer;

Enabls L5M Remate:

Server Log Target Directory :

Temp. Unit;

SNMP and General Settings

In the Settings command in the Tools menu, you can set following parameters.

Click OK once the parameters are properly configured for your application.

E
[ ] Sec

| mSec
CERE

E_-E:_\.i';'.r.ogram i;'i-les-(ﬁ:"é-éloacica_s-t-i-:"ﬁui.ﬁ.mer{t_&ﬁe.t"h;'i-or;i-tor_\.lijﬁwn[oaa;aﬂ I.ogs _i E

| Celziuz b !

12
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Field Description

Parameter Description

# Local Clip When this number of clips is reached on a machine, a message

Threshold will be displayed to warn the user that a cleaning and purge will
soon be necessary on that server.

Rem. Cap. Same warning as the previous one but based on the server

Threshold remaining storage capacity.

SNMP Polling Wait time between polling. A small period will guarantee fast

Period refreshing of data but will request high data flow on the network

SNMP Time Out

Enable Gigabit
ICMP Polling

ICMP Time Out

Enable Server
Reboot

Enable SNMP Log

Enable Server
Explorer

Enable LSM
Remote

Server Log Target

Directory
Temp. Unit

while a long period will display less up-to-date data but will reduce
the load on the network.

Delay after which a host will be considered as not responding. An
alert message will be displayed in the event log if such an event
happens for a monitored host.

The automatic discovery process total duration depends on this
parameter.

Enables the pinging of the Servers GbE ports.

Time Out for the pinging of the Servers GbE ports

If this option is enabled, XNet Monitor will be able to initiate a
reboot of any monitored server through the Reboot command in
the contextual menu opened by right-clicking on a host in the
Monitored Device Tree.

If this option is enabled, XNet Monitor will keep a log file with all
SNMP messages.

Enables the Explore option from the Server Name contextual
menu in the Monitored Devices Tree. The Explore option opens a
ftp session on the server.

Enables the LSM Remote option from the Server Name
contextual menu in the Monitored Device Tree.

Path to the directory used to store the SNMP log files.

Unit in which the temperature is expressed.

2. Configuration
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3.

3.1.

Monitoring

Start Monitoring

Once servers and hosts have been added in the groups, the monitoring is started by
clicking on the Start command in the Monitoring menu.

To stop the monitoring once it is running, simply click on the Stop command in the same
Monitoring menu.

The monitoring status is available in the status bar at the bottom of the XNet Monitor
window.

T C——— | Sewer1235 25/04/2008

Polling 1.1.20.1 (host 1/3) *

» ’Polling not started’ means that the monitoring has not been started yet since the
application launch.

* ‘Polling’ followed by IP address means status data are presently read from the
selected host MIB.

*  ‘Waiting x/y sec’ indicates that the monitor is waiting for next polling process. It has
already been waiting for x seconds out of a total of y seconds (according to related
parameter setting).

+ ‘Polling ended’ means that the monitoring has been stopped by the user. At monitoring
restart, hosts will be immediately polled and the waiting period will be reset.

NOTE

When you start up XNet Monitor, the monitoring is always stopped and must be
started manually using the Start command.

14
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3.2. Monitoring List

3.2.1. Description of the Monitoring List

Overview

The Monitoring List area shows the groups of EVS servers and other EVS hardware, their
status, and a set of parameters on each hardware.

The Monitoring List pane contains the areas highlighted on the screenshot below:

Name SN Soft. Rev. State erfloch Analog LTC  Disk PSU XMET Status ~ Traffic DB Status Loc. Clips  Rem. Capacity
24940 [15.02.16 | Runni [ Vaid OK (0o _ _ _ _ 15:43.47 [98%]
25120 [15.02.16 Running D 21:15:45 [98%
FDR-XT01-SN148... | 148.. |15.01.37 Running Vakd blackburst Valid OK {Dsp) OK | Stand-alone | NotApp... | Ok |57 22:29:21 [98%]
FDR-XTO2-SN117... | 117... |15.02.28 B o biackburst  Vald OK (0sp} Unknown | Unknown | Unknown | Unknown | 78 19:43:59 [96%]

Area Description

The table below describes the various parts of Monitoring List area:

Part Name Description

1. | Column heading Type of information available in the given column.
The columns available in the Monitoring List are selected
and ordered as defined in the section "Customizing the
Monitoring List" on page 9.

2. Group node Name of the device or server group as defined in the
Monitored Device Tree.

3.  ServerlList Information on EVS servers and other EVS hardware
belonging to a group. For more details on the fields
available in this section, "Fields in the Monitoring List" on
page 16.

Clicking on a row corresponding to an EVS server or other
hardware will display the detailed information on this host
in the Server Details area.

3. Monitoring 15
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3.2.2.

Fields in the Monitoring List

The list of fields described in the table below is not exhaustive. It includes the fields
available in the default display:

Name Description
Name name of the EVS server.
The name displayed is assigned in the following order of priority,
based on whether a value is assigned or not: facility name, net
name or IP address.
A color circle in front of the EVS server indicates its status:
e green: no active alert present for the server
* red: at least an active alert present for the given server
» gray: XNet Web cannot retrieve information with the SNMP
protocol.
SN server's unique serial number.
Soft Rev. server software revision.
State functional status of the EVS server or other EVS hardware.
Genlock presence or absence of genlock synchronization signal, and its
type.
Analog LTC status of LTC (Longitudinal Time Code) analogue signal.
Disk disk connection status, and the number of spare disks.
PSU status of the power supply units.
XNet Status status of the SDTI network connection.
Traffic network traffic status.
DB Status status of the server database.
Loc. Clips number of clips stored on the server.

Rem. Capacity

remaining recording capacity on the EVS server in hours, and
percentage.
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3.3.

3.3.1.

3.3.2.

Server Details

Overview on the Server Details Area

The Server Details area is located on the right hand side of the Monitored Device List.

When you select an EVS server in the Monitored Device List, the Server Details area
provides detailed information on the selected server.

This information is organized in five tabs, which are themselves organized in different
group boxes:

Tab Name Included field groups

Status General information, data about A/V, network, controllers, GbE
connections, and channels

Storage Information on disk capacity, array definition, disk numbers, and disk
models

Hardware List of the boards fitted on the EVS server

Codes List of Codes installed on the EVS server

MIB Browser  View on the MIB (Management Information Base)

Temperature Temperatures measured at various points in the EVS server

When you select another EVS hardware in the Monitored Device List, the Device Details
area provides data on the selected hardware, its drives and communication interfaces.
See section "Device Details" on page 29 for more information.

Status Tab

Overview

In the Status tab, the main parameters are organized in several group boxes as shown on
the following figure.

3. Monitoring
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Status  Storage  Hardware Codes  Mib Browser Temperature

General Audio-Video Contraller ', Protocol

Type: XT4K AV Channels: Zin Zout 16audio Port Controller\Protocol Connection State

Facility Name: FDR-XT04-5SN161050 Video Std: UHDTV-4K 59.94Hz RS422 #1 EVSRemote Defined

Base Config: MulticamL5M Codec Corfig:: Intra+Lo-Res RS422 12 EVSRemate Defined

Serial Number: 161050 On Air Codec: XAVC 300

i RS5422 H5 IPDP Defined

Version: 16.01.14 Intra Codec: KAVC 300

State: USESEEEN o BiRae (600 Hbps Bhemet #5106 | LinX Defined

F5U Unknown LongGOP Codec Nat applicable Bthamet 50107 tnX Defined

Genlock Valid blackburst LongGOP Bt Rate: | Not applicable

LTC: Valid Lo-Res Codec Mipeg

Local Clips: 20 Lo-Res Bit Rate 5000 Mbps

Met Clips: 0 Interface: G Level-A

Rem. Capacity: 28:40:00 [99%] HDR: HLG - Rec2020 Gigabit Connections Settings

Clip Capacity: Global LAN PC1 Gbe Port1 Gbe Port2

Loop Recarding On Networic L Uniky Unker

Up T 5 SDTI: No relay 2570 Status il Inknown Inknown

p Time 0day, 174528 Net #-Name: 2 FORSTOA P Address | 10.128.110.4 101281124 10.129.113.4
gate :ge - 20181107 09.00:06 Net Type (Cra): NotApplicable(Server) Subnet Mask 2552552540 | 2552552550 | 255.255.255.0
ync PCto ez -
Period: 031500 Clip Edt by network: | Yes Def. Gateway | 10.125.111.254 10.125.112.254 10.125.113.254
) : KNet Status: Unki

PC froe disk space: | 216256 VB 'S s Inknown MAC Address | 00031D1021C7 001CF3012C81 001CF3012Ca0

DB Status: T Traffic: Unknown Phys. Interface | Not Appicable | 1Gbeon TGE | 1Gbe on TGE

Rec Train Expiration:| Unknown Netuork Copy/Push| GigE Mode Static Static Static

GigE Open Conn:  |0V/6

Channels

Channel Status Config Rem Capacity LTC User TC st Ctd 2nd Cid Parallel Cid QsD
Unknown Rec 3G Level-A (50%) | 14:20:00 2018-11-06 17:49.45;... | 2018-11-07 00:08:49;... | EVSRemote Primary
CAMB Unknown Rec 3G Level-A (50%) | 14:20:00 2018-11-06 17:45:45;... | 2018-11-07 00:08:45.... | EVSRemote Primary

PGM 1 Unknown Play 3G Level-A 2018-11-06 17:45:45;... | 2018-11-07 00:08:45;... | EVSRemote IPDP Paralle! Main
PGM 2 Unknown Play 3G Level-A 2018-11-06 17:49:45; .. | 2018-11-07 00:08:49; .. | EVSRemote IPDP Paralle! Main

The different group boxes and their parameters are detailed hereafter.

You will find more details on many of these parameters in the Configuration manual of the
relevant EVS server.

Note
If Multicam is not active and running on the selected server, most of the
parameter fields will be left blank.

General Area

The table below describes the fields available in the General area:

Parameter Description

Type Servertype: XT3, XS3, ...

Facility Name Name given to the product by the user.
Base Config. base configuration used to start the server.

In case of a Dual LSM configuration, the term Dual is added
next to the active base configuration.

Serial Number server's unique serial number.

Version server software revision.

State functional status of the EVS server or other EVS hardware.
PSU status of the power supply units.
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Parameter Description

Genlock presence or absence of genlock synchronization signal, and its
type.

LTC status of LTC (Longitudinal Time Code) analogue signal.

Local Clips number of clips stored on the server.

Net Clips total number of clips stored on the whole SDTI network.

Rem. Capacity

Clip Capacity
Loop Recording
Up Time

Date Time

Sync PCto TC

Period

PC Free Disk Space

DB Status

Rec. Train Expiration

remaining recording capacity on the EVS server in hours, and
percentage.

Clip capacity as defined on the server: Global or Per Channel.
Loop recording mode as defined on the server.

Elapsed time since the last boot.

MTPC date and time.

Indicates whether the internal TC is synchronized to the
timecode read on the LTC input of the server and whether the
TC discontinuities detected on the LTC input of the system are
cleared.

Period at which the Sync PC to TC is applied.

available space on the MTPC disk in megabytes (MB) or
gigabytes (GB).

status of the server database.

Time lapse by which the field counter for the record trains has to
be manually reinitialized on the EVS server.

Failing a reinitialization, the record train will not longer be
recorded. Warning messages are issued in Multicam.

Audio-Video Area
The table below describes the fields available in the Audio-Video area:
Parameter Description
AV Channels configuration defined for video and audio channels:
» number of IN and OUT video channels
* number of audio embedded mono channels per video
channel
Video Std video standard used on the server ports.
Codec Config Codec essence(s) active on the EVS server.
On Air Codec Codec in which the video is played out on the EVS server.
Intra Codec Intra codec in which the video is stored on the EVS server.

Intra Bitrate

Bitrate of compressed video data for the Intra codec.
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Parameter

Description

LongGOP Codec

LongGOP Bitrate
Lo-Res Codec

Lo-Res Bitrate

LongGOP codec in which the video is stored on the EVS
server.

Bitrate of compressed video data for the LongGOP codec.
Lo-Res codec in which the video is stored on the EVS server.

Bitrate of compressed video data for the Lo-Res codec.

Interface Connection interface an EVS server will use in 3D, 1080p,
UHD-4K resolutions or with the XIP or XT-VIA rear panel.
HDR OETF function (opto-electric transfer function) used for High
Dynamic Profile.
Network Area

The table below describes the fields available in the Network area:

Parameter Description

SDTI SDTI (Serial Data Transport Interface) network type.

Net # - Name Server identification number and name on the SDTI network.
Net Type (Cfg) server type on the SDTI network.

Clip Edit by network

XNet Status
Traffic

Network Copy/Push

GigE Open Conn

The possible values are:

* Master
e Server
« Client

* Not Applicable (SDTI not present or set to off).

Specifies whether a clip can be edited through the network or
not.

status of the SDTI network connection.
network traffic status.

Preferred network (SDTI or Gigabit) for copy, move and push
actions on clips.

Number of open GbE connections on a given port.

Controller / Protocol Area

The table below describes the fields available in the Controller / Protocol area:

Parameter

Description

Port

Controller\Protocol

Port used by the server controller.

Controller or protocol used on that port.

20
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Parameter

Description

Connection State

Connection status of the control port.
Ifitis disconnected, Disconnected displays in red, and this
generates an alert.

Gigabit Connection Settings Area

The table below describes the fields available in the Gigabit Connection Settings area for
each PC LAN (max. 2) and each GbE port (max. 2) being used on the EVS server:

If teaming is applied on the GbE ports, the GbE #2 port is referred to as "Not Present".

Parameter Description

Status Status of the GbE connection.
IP Address IP address of the interface port.
Subnet Mask IP mask of the interface port.

Def. Gateway
MAC Address
Phys. Interface
Mode

Default gateway used by the interface port.
MAC address of the hardware
Physical location of the corresponding GbE port

Method used for IP address assignment (static or dynamic)

Channels Area

The table below describes the fields available in the Channels area:

Parameter

Description

Channel

Status

Config

Rem. Capacity
LTC
UserTC

Name of the record channel (CAM) or play (PGM) channel.

Status of the channel:

*+ CAM: Recording, Rec Idle

+ PGM: Ready, Playing, Live, Idle

If a channel has no audio or video, it will be displayed in red with
one of the following indication:

* ('A)when the audio is missing

* (V) when the video is missing

*  ('AV)when the audio and video are missing

Configuration of the channel as record or play channel.
SLSM recorders, as well as the number of phases, are
specified in this field.

remaining capacity for each recorder channel.
LTC timecode of the channel.

User timecode of the channel.
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Parameter

Description

1st Ctrl

2nd Ctrl
Parallel Ctrl
OSD

Primary controller defined for the selected channel.
Possible values are: EVS Remote, EVS XTNano Remote,

AVSP, IPDP
Secondary controller defined for the channel, if any.
Controller used in parallel mode.

Controller (main or secondary) managing the OSD display
characters in parallel mode.

3.3.3.

Storage Tab

Overview
Status Stor@ge  Hardware Codes  Mib Browser
General Amays
Remaining Capacity: [17:54:40 [96%] Storage type: [Sas PSU  Fans Themal
Mominal Capacity: W RAID type: ’{5*1)7
EXT3
RAID EXT2
1 2 3 4 5 6 7 2 5 0 11 12 13 14 15 16 EXT1
h|||||||||||||||mn;; oK
Disk: status
h'l 2 3 4 5 6 7 2 5 0 11 12 13 14 15 16 17 18 19 20 21 22 23 24
EXT3
EXT2
EXT1
INT1T |[R1 |R1 |=< |[R1 |R1 [R1

Disk temperature

EXT3

EXT2

EXT1

INTT |30 |31

3

Disk: Details...

22
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General Area

The table below describes the fields available in the General area:

Parameter Description

Rem. Capacity It specifies the remaining capacity of the storage expressed as
a video duration (hours, minutes and seconds) as well as a
percentage.

Nominal Capacity It specifies the total capacity of the storage expressed as a

video duration (hours, minutes and seconds).
Storage Type It specifies the type of disks: SAS.

Raid Type It specifies the type of RAID:
*  4+1: four disks and a parity disk, with a spare disk
» 5+1:five disks and a parity disk, without a spare disk

Arrays Area

The table below describes the fields available in the Arrays area:

Parameter Description

PSU It specifies the status of the PSU on the given array.
See section "PSU HDX" on page 40 for examples of values for
this field in case of SAS-HDX array. The values are the same
for other arrays types.

Fans It gives the state of the fans on the given array.
See section "Fan HDX" on page 40 for examples of values for
this field in case of SAS-HDX array. The values are the same
for other arrays types.

Thermal It gives the temperature status on the given array.
See section "Disk Thermal" on page 41 for field values.

Raid Area

This area gives indication on the number of RAIDs defined in the server and their
respective identification (R1,...)

Parameter Description

Raid ID It specifies the RAID storage system identification

3. Monitoring
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Disk Overview Tab

Disk Status Area
This area gives indication on the localization of each RAID and on the spare disks in the
arrays:

The xx sign (red) identifies faulty disks, that should directly be replaced, especially when
you work without spare disks.

The sign (red) identifies disks other than EVS disks.

The sp sign (green) identifies the spare disks.

Digk. status
& 0B oC oD OE 14 18 1L 1D 1E 24 2B | 2C ) 2D Z2E

KARN 1 (R1 (BT |==  |R1

Disk Temperature Area

This area provides the internal temperature of each disk.

24
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Disk Details Button

The Disk Details button gives access to the Disk Information window:

L Disk Information — O X
ID State Cap (Gb) TempiC®) Sector Size (Byte) Model Rev. Level SN

273 30 512 SEAGATE S5T930060555 0002 EXPICRPS
279 K1 512 SEAGATE STS30060555 0002 EXP3BD2D
273 512 SEAGATE S5T930060555 0002 EXP3IC3V0L

INT1-4 Ok 279 35 512 SEAGATE STS30060555 0002 EXP3ISZIL

INT1-5 Ok 27 K1 512 SEAGATE ST930060555 0002 6XP3BFRS

INT1-6 Ok 279 33 512 SEAGATE STS30060555 0002 EXP3I5ZHA

INT1-7 NetPresent !

INT1-8 NetPresent /

INT1-3 NotPresent /

INT1-10 | NetPresent /

INT1-11 | NotPresent /

INT1-12 | NotPresent /

Parameter Description

ID Disk identification

State Disk status: OK, not present, spare, ...

Cap Disk capacity in Gigabytes

Temp Disk internal temperature in the unit defined in the general

display settings

Sector Size Size of the disk sector

Model Disk manufacturer and model

Rev. Level Disk revision Level

SN Disk serial number
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3.3.4.

Hardware Tab

Overview

The Hardware

tab lists the available modules and boards installed in the server along with

their respective version or revision number and their configuration when relevant.

Status  Storage Hardware Codes  Mib Browser Temperature

Boards

MName

MTPC Board

Version

HS-873: Id=0xAG

H3XP-5 CPU Board

Id=0xC0. Revision=0x08, Jumpers=0x0F

V4X Base Board #0

1D=0xD0, IDE=(x5

CH#D (Vdx) Str"V4x 1.0 " Feat:0x0000
CH#1 (v4x) Str"V4X 1.0 " Feat:0x0000
CH#H2Z (Vdx) StrV4X 1.0 " Feat:x0000
CHH3 (V4x) Str"V4X 1.0 " Feat:0x0000
ACODEC A3X: 1d=0xA3, lde=0x0A, Ide2=0x3C

Multiviewer Board

Mv4: 06.03 31/08/17 - Fpga (x601 - Product Id 060

TGE

TGE 10GBe: Vs 0.1 Feat. 0x00/0x00/0x 00/ 0x 00

General

Mame

Physical Memory

HW Edition 51
Board Area
Parameter Description
Name Name of the board or module
Version Revision of the board or module, and additional parameters

General Area

Parameter Description

Physical RAM of the MTPC board

Memory

Hardware  version of the EVS server hardware, that corresponds to a specific set of
Edition board revisions. The components of each hardware edition are detailed in

the Tech Ref manual, Hardware Edition History section.
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3.3.5. Codes Tab

The Codes tab lists the license codes activated on the server along with their description.

Status Storage Hardware Codes  Mib Browser Temperature

Number Description

2 Authorize 5D corfigurations
3 Authorize HD corfigurations
4 Authorize video configuration changes
5 Avid DNxHD HD Codec

[ Apple ProRes 422 HD Codec
8 DVCPRO HD Codec

9 DVCPRO 50 Codec

10 Mipeg Codec

1 IMX Codec

12 MpegZintra Codec

13 AVC-ntra HD Codec

15 KAVC-Intra HD Codec

16 DhxHR 4K Codec

17 ProRes 4K Codec

18 AVC-Uttra 4K Codec

13 KAVC 4K Codec

20 LSM Hypemotion

21 1080p Dual-Link

22 1080p 3G

23 3D Dual-Link

24 DG

3.3.6. MIB Browser Tab

The MIB Browser tab allows to view the MIB (Management Information Base) and
provides a description of the parameters that can be polled. This tab is dedicated to
maintenance operations.

| Status || Storage | Hardware | Codes | Mib Brawser

Module MName

EV'3-GLOBAL-REG
{ODLICT-MIE

EV5-SERVER-MIB
EV5-=5SERVER-EXFR-MIB
EVS-+<SERVER-MIB
SHMPY2-CONF

SHMPY 25K
SHMPYZTC

= wsPrdtMIB(2)

== evsPrdtMIBM otifications(0]
“[1] ewsPrStateChangel1)

== evsPrdiGeneral1]

=[i@ evsPrtT able(1]
=4 evsPrdtEntry(1]

o evsPrdtindex(1)
evsPrdtTvpe(2]
evsPrdtDescr[3]
evsPrdtSeralMunmben(4]
evePrdtSoftersion(5)

| ol b ewsPrdiState(B)
25 evsPrdigent(2)
i D evsPrdtdgentyersion(1]
D evzPrdttd axTrapClients(2]
. D evsPrdtT rapClientM extindesPosition(3]
= 'E evzPrdtT rapClientCiaT able(d)
=% evsPrdtTrapClientCraEnty(1]

>
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3.3.7. Temperature Tab

Overview

The Temperature tab lists the temperatures measured in several points of the EVS server.

The measures are always given in Celsius degrees. The temperature settings do not
impact these measurements.

+  Between 50 °C (122 °F) and 80 °C (176 °F), the warning range is reached and the
temperature is displayed on an orange background.

*  Above 80 °C (176 °F), the alert range is reached and the temperature is displayed on a
red background.

These temperature measurements can also be displayed in the Monitoring List

Status Storage Hardware Codes Mib Browser Temperaturs

Temperature

Name Walue C
Hex Board 36
Hex CPU 53
Hx Memary 3
WCodec 45
VCodec2 45
VCodec3 51
VCodecd 57

Temperature Area

Parameter Description

Name Name of the board or module where the temperature is measured:
* Hxx Board: Controller board
*  Hxx CPU: CPU module on the controller board
*  Hxx Memory: Memory module on the controller board
* VCodec1: Codec1 module
« etc.

Value °C Temperature in Celsius degrees
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3.4.

Introduction

Device Details

If a hardware other than an EVS server is selected in the Monitored Device List, the
Device Details area on the right displays detailed SNMP information.

This information is organized the following tabs, which are themselves organized in

different group boxes:

Tab Name

Included field groups

Status

drives, and the communication interfaces

MIB Browser

Applications installed on the hardware, data on the computer, the

View on the MIB (Management Information Base)

Status Tab

In the Status tab, the main parameters are organized in several group boxes as shown on

the following figure.

Status | Mib Erowser

Evws Products

Type Yersion
212850
®TAccess 11380
Computer
Mame: ®F73130
CPU Uzage: 0% 0%

Physical Memary: 489 /997 MB [49 %)

Up Time; 21:43:17.04
Date Time: 2010-06-02 13:43.25
Interfaces
Description Status | MTLU Speed

SN 1500 1000 Mbps
Intel(R] PROA00... | Up 1500 1000 Mbps
IntellR] PROADD.. [Up 1500 | 1000 Mbps

State Cusztam Mame
Rurining Uk niown
Drives
M ame Total Size Free Space
Restore (R] 19.5GB 14.0 GB
KT7(F] 465.8 GB 281 GB
KTI7(E) 4E5.8 GB 444 4GB
Syztem (C) 19.5GB E.7 GH
Phys. Address IP Address Met Mask MIC IM MHIC OUT
01 ccOda8ef? 0.0.0.0 0.0.00
015177EBbd2 128122 255.256.255.0 | 2,801 533 £3.825
0151 76fed8f 1.1.5312 286.266.0.0 | 20,783,986 20,697,293
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The different group boxes and their parameters are detailed hereafter.

EVS Products

Parameter Description

Type EVS application name.

Version Server software revision.

State Server state: running, in maintenance, faulty, halted, unknown.

Custom Name | Name given to the product from the MIB.

Computer
Parameter Description
Name Name of the computer.
CPU Usage Percentage of use of central processing unit (CPU).
Physical Memory Computer data storage used from the total amount.
Up Time Elapsed time since the last boot.
Date Time MTPC date and time.

Drives

This area lists the hard disks drives from the computer.

Parameter Description

Name Name of the computer.

Total Size Total size (GB) of the drive.

Free Space Free space (GB) still available on the drive.
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3.5.

Interfaces
Parameter Description
Description | Generic description of the communication interface.
Status Up or Down
MTU Maximum Transmission Unit: size (in bytes) of the largest protocol data
unit that the layer can pass onwards.
Speed Data transfer rate in Megabits per second.
Phys. Memory address that is electronically (in the form of binary number)
Address presented on the computer address bus circuitry in order to enable the data
bus to access a particular storage cell of main memory.
IP Address ' Internet Protocol address of the communication interface.
Net Mask | Prefix bit mask expressed in quad-dotted decimal representation. For
example, 255.255.255.0 is the subnet mask for the 192.168.1.0/24 prefix.
NIC IN Number of octets getting through the network (input)
NIC OUT | Number of octets getting through the network (output)

MIB Browser Tab

See section "MIB Browser Tab" on page 27 for an overview of the MIB Browser tab.

Extracting SNMP Information

To extract SNMP information relative to an EVS server, proceed as follows:

1. Right-click on the server in the Monitored Device Tree.

2. Select Extract SNMP Information from the contextual menu.

The extraction starts and once it is done, the SNMP Information Extraction window
displays the .html file name and its storing folder and path:

SNMP information extraction

SMMP information successfully extracted For XT_ADL. Available under C:\Program Files\EVS Broadcast Equipmentixiet Monitor\Downloaded
lagsi22100-2, htrnl
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3.6.

3.6.1.

Alert Messages

Description of Alerts Pane

Introduction

The Alerts pane is displayed below the Monitoring List pane on the Monitoring window.

It shows the list of SNMP alerts generated for the monitored devices (host or host groups)
selected in the Monitored Device tree.

The alert messages are displayed until you acknowledge them.
In the Alerts pane, you can:

» display alerts based on alert categories.

» sort the columns in the alert list.

» acknowledge an (active) alert.

Use the Filter drop-down menu to select the alerts to be displayed:

Category Description

All All alerts that occurred during the selected period are displayed.
Acknowledged  Only alerts that have already been acknowledged are displayed.

Not Only alerts that do not have been acknowledged yet are displayed.
Acknowledged

Area Description

7

Stat Date: | jeud 6 jullet 2017 [+ | Fter: [Not Acknowledged <| [ Ack Aetie)
EndDate: | jeud 6 jullet 2017 (G|

IP Address
10.129.110.4

Date
06-07-17 10:47:21

Alett Message

FOR-XT4K-5SN161050

FDR-XTAK-SN1G1050 | 10.129.110.4 0607-1710:4721 | CAM E: Audio Embedded Missing
 FDRXTAK-SN161050 |10.129.110.4 |0607-1710:4721 | CAM D: Audio Embedded Missing
 FDRXT4K-SN161050 |10.129.110.4 |060717104721 | CAMC: Audio Embedded Missing
 FDR-XT4K-SN161050 |10.129.110.4 |060717104721 | CAM B: Audio Embedded Missing
 FDR-XT4K-SN161050 | 10.129.110.4 |0607-1710:47:21 | CAM A: Audio Embedded Missing
|FORXTAK-SN161050 |10.129.110.4 060717104721 |Gbe Por2: operational status s Down
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3.6.2.

The table below describes the various parts of Alerts pane:

Part Name

Description

1. Alert filter

Drop-down field that allows you to select the alert
category to be displayed in the grid, as well as the date
range when the alert was generated.

On the right, the Ack Alert(s) icon allows you to
acknowledge all displayed alerts.

2. Column heading Type of information available in the given column.

Clicking on the column heading allows the sorting of the

elements in ascending or descending order.

The columns displayed cannot be modified:

* Name: Name of the host

* |IP Address: IP address of the host

» Date: Date and time when the alert was generated

» Alert Message: Error message (For full information on
error messages, "List of Possible Alerts" on page 34).

3. | Alert Information Information on the alerts displayed.

Managing Alerts

Introduction

This topic explains how you can display and manage alerts from the Alerts area in the
Monitoring window. The possible actions are summarized in a table below.

Possible Actions on Alerts

In order to ...

Proceed as follows:

Filter the alerts to
be displayed

Sort the alert items
based on the values
of a column
(ascending or
descending order)

Acknowledge alerts

Select the requested alert category in the Filter drop-down field,
and the date range in which the alerts to be displayed have been

generated.
Start Date: [mercredi 5 jullet 2017 [~ | Fiter: [H] [ | Ack Atetis)

EndDate: | jeud 6 jullet 2017 [~ | &ﬂﬂ!_ﬁ
w - — Mot Acknowledged

Click the column heading on which the alert items should be
sorted.

Click the Ack Alert(s) on the right of the filter fields.
All alerts displayed are removed from the Alert list, and added to
the Acknowledged list.
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3.6.3. List of Possible Alerts

Introduction

The section describes the fields for which an alert can be generated and the associated
default message(s) (normal status) and alert/error messages.

The warnings are displayed in orange, and the errors in red.

Working Principle

When an error is generated for a field, it is displayed in the Monitoring window:

+ as an alertin the Alerts pane if the given field is not selected in the Alert
Configuration window.

The alert must be acknowledged by an administrator user to be removed from the list
of active alerts. It is then sent to the list of acknowledge alerts.

» as an error message in the Server Details pane, and possibly in the Monitoring
List pane (if the related field is displayed).

When the SNMP information is sent back and when the situation is back to normal or
when the alert is acknowledged, the field status is updated accordingly, and the error
is replaced by the normal status.

Polling Status

It specifies the status of the polling service. It indicates: whether the polling service is
running correctlywhen the polling service last sent a query to the server (time interval in
hh:mm:ss from current time)

Possible Values

Status

Message Explanation e

OK (00:03:00) The polling service is working correctly, and the SNMP Info
data was last sent 3 minutes ago.

No response to  An ICMP (Internet Control Message Protocol) timeout was = Error
IMCP polling generated: the information was not sent in the requested
time interval.

No response to = An SNMP timeout was generated: the information was not = Error
SNMP polling  sentinthe requested time interval.

State

It specifies the functional status of the EVS server or other EVS hardware.
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Possible Values

Message Explanation _?)t;t:s

Running The EVS server is running a given configuration. Info

Not Running The EVS server is not running a configuration Info

Initializing The EVS server is initializing (in the boot sequence). Error

Maintenance The EVS server is in the Multicam Setup window, hence it = Error
is not running a given configuration yet.

Halted The EVS server is turned off. Error

GbE 1/2 and PC LAN 1/2 Status

It specifies the operational status of the Gigabit Ethernet interface connectors (port 1 & 2),
the PC LAN connectors (port 1 & 2), as well as issues related to GbE and/or PC LAN

teaming.

Possible Values

Message Explanation Status GUI
Type

Up The corresponding GbE or PC LAN interfaceis | Info Server
installed and running well. Details

Down The corresponding GbE or PC LAN interfaceis | Error Server
not working. Details

Not present The corresponding GbE or PC LAN is NOT Error Server
installed. Details

GbE Port 1: The GbE port 1 is not working. Error Alerts

operational

status is Down

PC LAN Port 1:  The PC LAN port 1 is not working. Error Alerts

operational

status is Down

Team Up The GbE or PC LAN interfaces are running well, = Info Server
and the both links work correctly in teaming. Details

Team Link 1 The GbE link 2 or PC LAN link 2 is functional Error Server

Down whereas the GbE link 1 or PC LAN link 1 is Details
either not cabled, or does not work properly.

Team Link 2 The GbE link 1 or PC LAN link 1 is functional Error Server

Down whereas the GbE link 2 or PC LAN link 2 is Details
either not cabled, or does not work properly.

Team Down The GbE or PC LAN interfaces are installed but = Error Server
do not work properly on both links. Details
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Status

Message Explanation Type GUI
GbE Port 1/ The GbE link 2 or PC LAN link 2 is functional Error Alerts
PC LAN Port 1:  whereas the GbE link 1 or PC LAN link 1 is

operational either not cabled, or does not work properly.

status is

degraded - team

link 1 down

GbE Port 1/ The GbE link 1 or PC LAN link 1 is functional Error Alerts
PC LAN Port 1:  whereas the GbE link 2 or PC LAN link 2 is

operational either not cabled, or does not work properly.

status is

degraded - team

link 2 down

Controller

It specifies the connection status of a given controller enabled on an EVS server.

Depending on the pane where the message is displayed, it is displayed in slightly different

ways.

Possible Values

. Status
Message Explanation - GUI
OK All defined controllers are connected, which means | Info Mon.
up and running. List
Connected The corresponding controller is up and running. Info Server
Details
Defined The corresponding controller is defined in the Info Server

Disconnected

XX on RS422
#Y
disconnected

configuration but is not used

The corresponding defined controller is
disconnected, or the external communication has
been lost.

The given controller(s) (XX) is/are disconnected on
the given RS422 port number (Y) of the EVS server.

Details

Error  Server
Details

Error  Alerts
Pane
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Channels

It specifies errors on the status of the record or play channels.

Possible Values

. Status
Message Explanation e GUI
Recording Normal status on the recorded Info Server
media. Details
Recording ('A) Embedded audio missing on the Error Server
recorded media. Details
CAM X: audio Error Alerts
embedded missing
Recording (!V) Video missing on the recorded Error Server
media. Details
CAM X: video missing Error Alerts

Genlock

It specifies the presence or absence of genlock synchronization signal, and its type.

Possible Values

Message Explanation Status Type
OK Blackburst A valid Blackburst signal is present. Info
OK Tri-level A valid Tri-level signal is present. Info
Bad Blackburst Bad Blackburst signal Error
Unknown Blackburst No Blackburst signal detected Error
Bad Tri-level Bad Tri-level signal Error
Unknown Tri-level No Tri-level signal detected Error

Analog LTC

It specifies the status of LTC (Longitudinal Time Code) analogue signal.

Possible Values
Message  Explanation Status Type
OK A valid LTC signal is present on the EVS server. Info
Missing No LTC signal is detected on the EVS server. Error
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Message | Explanation Status Type

Corrupted AbadLTC oranLTC drift is detected on the EVS server. Error

Local Clips

It specifies the number of clips stored on the server.

For local clips, the alert generation depends on the threshold defined for the Local Clips
field in the Monitoring settings defined in the Tools > Settings menu. The default
threshold is 4000.

Possible Values

. Status

Message Explanation Type

3500 When the number of clips is displayed in black, it means the number  Info
of clips on the EVS server does not exceed the threshold defined for
the maximum number of local clips.

4200 When the number of clips is displayed in red and bold characters, it = Error
means the number of clips on the EVS server exceeds the threshold
defined for the maximum number of local clips.

DB Status
It specifies the status of the server database.
Possible Values

Message Explanation Status Type

OK The DB is OK. Info

Corrupted The DB is corrupted. Error

XNet Status
It specifies the status of the SDTI network connection.
Possible Values
. Status

Message Explanation Type

Connected The EVS server is connected to the network. Info

Connecting The EVS server's connection to the network is in Info

progress.
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Message Explanation ?;a;:s
Stand alone The system does not have the XNet license, or the Info
required hardware, or the SDTI network is disabled.
Not Connected The EVS server is not connected to the network. Error
Disconnected The EVS server is in a disconnection phase. Error
Connection fault The EVS server cannot connect to the XNet network = Error
due to an incompatibility error.
Traffic
It specifies the network traffic status.
Possible Values
Message Explanation -?;;t:s
Normal The traffic on the SDTI network is properly managed. Info
The SDTI network makes full use of the available capacity. Warning
(orange)
Corrupted The SDTI network is overloaded, has lost at least one Error

command from a controller, and is desynchronized.

Rem. Capacity

It specifies the remaining recording capacity on the EVS serverin hours, and percentage.

The alert generation depends on the threshold defined for the Remaining Capacity field in
the Monitoring settings defined in the Tools > Settings menu. The default threshold is

5%.

Possible Values

. Status
Message Explanation Type
48:01:53 (97%) The parameter is in a valid state (black font) when | Info
the Remaining Capacity threshold is not exceeded.
01:03:32 (2%) The parameter is in a warning state (orange font) Warning
when the Remaining Capacity threshold is
exceeded.
00:00:00 (0%) The parameter is in an error state (red font) when Error
the Remaining Capacity is null.
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PSU

It specifies the st

atus of the power supply units..

Possible Values

Message Explanation ?;apt:s
OK (1) Only one PSU is installed on the server and is working | Info
fine
OK (2) Two PSUs are installed and are working fine Info
1 PSU 1 The first PSU is down. Error
!PSU 2 The second PSU is down. Error
PSU HDX

It specifies the status of the power supply units of the external SAS disk array.

Possible Values

Message Explanation -?;;t:s
OK (1) Only one PSU is installed on the SAS-HDX disk array and is Info
working fine
OK (2) Two PSUs are installed on the SAS-HDX disk array and Info
working fine.
/ No external storage system is installed. Info
1 PSU1  Thefirst PSU of the SAS-HDX disk array is down. Error
1PSU2  The second PSU of the SAS-HDX disk array is down. Error
Fan HDX
It specifies the state of the fans on the external SAS disk array.
Possible Values
Message Explanation Status Type
OK The fans is/are operating. Info
/ No external disk array is installed. Info
!Fan 1 The fan 1 is faulty. Error
! Fan 1,2 The fans 1 and 2 are faulty.
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Disk Thermal

It specifies the temperature on the internal and external disks.

Possible Values

. Status
Message Explanation -
OK All temperatures measured on disks are OK. Info
INT 1: Rising The temperature of disk 1 on the internal disk Warning
array is rising (between 50 and 55°C).
EXT 2-3 : Rising The temperature of disk 3 of the second external =~ Warning
disk array 2 is rising (between 50 and 55°C).
INT 1-2 : Overheating = The temperature of disk 2 of the first internal disk  Error
storage board 1 exceeds 55°C.
RAID
It specifies the status of the raids.
Possible Values
. Status
Message Explanation e
OK The raid system is working fine. Info
R1: The system is rebuilding raid 1 of the raid matrix, X standing for Warning
Rebuilt the part of the rebuild operation processed in %.
X% In the Server Details pane, Storage tab, the raid has an orange
background in the RAID area.
R1: The raid 1 of the raid matrix has lost a disk and cannot afford any = Error

Degraded ' new disk failure without loosing the full storage.
In the Server Details pane, Storage tab, the raid has a red
background in the RAID area.

Raid R/W Retry

It specifies the number of renewed attempts of read and/or write operations on disks of the

raids.

As soon as at least one read or write operation has been retried, this generates a warning.
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Possible Values

Message Explanation Status Type
Or / Ow 0 renewed read attempt, 0 renewed write attempt Info
Or/ 1w 0 renewed read attempt, 1 renewed write attempt Warning

Raid R/W Error

It specifies the number of errors in read and/or write operations on disks of the raids.

As soon as at least one read or write operation has failed, this generates an error.

Possible Values

Message Explanation Status Type
Or/ Ow 0 read error, O write error Info

Or/ 1w 0 read error, 1 write error Error

Disk

It specifies the disk connection status, and the number of spare disks.

Possible Values

Message Explanation Status GUI

Type

OK (1 sp) All disks are connected and accepted by the RAID | Info Mon. List
matrix, and 1 spare disk is available.

1 xx (6 sp) All disks are connected and accepted by the RAID  Error  Mon. List
matrix, but one disk is faulty, and 6 spare disks are

available.
OK The given disk is working fine. Info Server
Details
Spare The given disk is a spare disk. Info Server
Details
INT/EXT X-X | The given disk on the internal or external array Error  Alerts &
Disconnected (array number + disk number) is out of the RAID Server
matrix. Details
INT/EXT X-X | Nodisk is connected on the internal or external Error  Alerts &
Not Present  array (array number + disk number). Server
Details

PC Free Disk Space

It specifies the available space on the MTPC disk in megabytes (MB) or gigabytes (GB).

42 3. Monitoring



USER MANUAL XNet Monitor 1.6

=V55

Possible Values

: Status
Message Explanation e
300 MB When the space available is more than the value defined in the Info
SNMP agent (100 MB), the label is in a normal state.
75 MB When the space available is less than the value defined in the Warning
SNMP agent (100 MB), the label is in a warning state. For PCs (no
MTPC card), this value is not displayed as a warning.
10 MB When the space available is less than 20MB, the label is in an Error

error state. For PCs (no MTPC card), this value is not displayed as

awarning.

Rec Train Expiration

It specifies that the remaining time left before you have to reinitalize the field counter for

the record trains.

Possible Values

Message

Explanation

Status

Tomi GUI

Record Train Maintenance
should be performed in less
than 12 weeks.

Record Train Maintenance
should be performed in less
than 28 days.

It remains between 4 and 12
weeks to reinitialize the record
train field counter.

It remains less than 4 weeks to
reinitialize the record train field
counter.

Warning Alerts

Error Alerts
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3.7. Disk Usage

The Disk Usage pane displays a summary of the total used and remaining disk space.
This total is computed for all disks available on the server or group of servers selected in
the Monitored Device Tree.

A color pie chart helps you to immediately visualize the disk usage of your system. More
precise figures are given over that pie chart, expressed as a used and remaining video
time in hours, minutes and seconds.

Uzed Capacity: 00:40:42
Rem. Capacity: 01:34:29
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4. Server Maintenance Tasks

4.1. Multicam Upgrades

4.1.1. |Installing a Multicam Version

How to Install a Multicam Version on an EVS Video Server

NOTE

With Multicam versions 15.XX and higher, the Multicam installation file (.gz file)
is directly made available and can be used as such in XNet Monitor to update

your Multicam version.

To remotely update Multicam on one or several servers, proceed as follows:

1. Inthe Tools menu, select Server > Install Versions. The Installation window

appears:

L installation

Er{]XNet
=] |:| Doc
| [ZEVSServerADL (15.02.16)

XT3-PGE (15.02.16)
B[ Test

i [JFDR-XT01-SN148320 (15.01.37)
. [JFDR-XTO2-SN117050 (15.02.28)
L [JFDR-XT03-5N128190 (1502 28)
. [CJFDR-XT4K-SN161050 (15.02.28)

Version: | C:\Users\ADL\Downloads\Muticam_15 02 28 55862 tar gz |:|

Install Close

2. Select the server(s) to update in the left pane of the Installation window.

As a reminder, the currently installed Multicam version is displayed next to each

server.

3. Inthe Version field, browse your computer to select the new Multicam installation zip

file.

4. Click on the Install button to start the installation process on all selected servers.
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5. Before the server upgrade starts, the installer checks the number of Multicam versions
installed on each server.

If more than 10 versions are installed on the EVS server, an error message appears
requesting you to remove old versions before installing a new one. Otherwise, the
upgrade process is automatically launched.

If you get the above message, do the following:
a. Click OK. The Remove Installed Versions window appears.

b. Remove the requested versions as described in the section "Installing a Multicam
Version" on page 45 "'Installing a Multicam Version" on page 45', on page
"Installing a Multicam Version" on page 45.

The upgrade process is then launched. When the servers are upgraded, they are restarted,
but you still need to launch the requested application.
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4.1.2. Removing a Multicam Version

NOTE

Servers currently running Multicam 14 will not show Multicam 15 versions and
higher.

How to Remove a Multicam Version from an EVS Server
To remove previously installed Multicam versions from an EVS server, proceed as
follows:

1. Inthe Tools menu, select Server > Remove Installed Versions.

The Remove Installed Versions window appears.

L Remove Installed Versions - [m] S
Server Version Version2 Version3 Versiond Versan5 Versian§ Version7 Versiong Version3 Versian 10
15021658807 |15.012956739 | 15011955511 | 15003952143 | 140212 140209 140204 140130 140051
101295920 15021658907 15012956739 |15.0119.55511 | 15004953827 | 140209 140204 140127 140065
10.129.110.1 15022850862 |15.0227.59793 | 15.0226.59501 | 140238
101291102 15022858862 |15.022758793 | 15022659501 | 140213
101291103 | 15022858862 | 15022758733 | 15.02 26 53501
101291104 | 15022858862 |15.0227.59793 | 15.02.26.59501

Close

2. Click the version(s) you want to remove.
The selected versions are highlighted in black.
Click the Remove Selected Versions button.
Click Close.

4.2. Remote Access to an EVS Server

4.2.1. Accessing Remotely a Server Desktop

To access remotely a server desktop, proceed as follows:

1. Right-click on a server name, and select Remote Desktop from the contextual menu.

A message appears to warn you that you are going to take control of the EVS server:

! E This operation will allow yvou to take conkrol of the server and potentially affect the recordingplawout, Are wou sure?
-

Ok, l ’ Cancel
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2. Click OK to open the server window:

B8 [10.129.59.20] Press ALT-C for CTRL-C and CTRL-TAB for ALT-TAE

CLIP:81 ADL XT3 (Loc) REC:81 ADL XT3 (Loc) TOT.@851 CLP:27:52:808 REM:15h43m .C
A F2:CLIP F3:CALL F4:PREF F5:VIEW F6 1 F7 2 F8:SRCH F9:CONNCT Fl1@:PLST

MODE CAM L £ ALT+Z: CHIVE
CLIPBOARD ---/-- - - - - ( ( " C PASTE CTL+DEL:DELETE
PAGE»1< 2 3 4 5 6 7 8 9 { > z 7 8 9 PL

From this window, you are able to navigate through Multicam Configuration module
exactly as you would access it using a keyboard.

4.2.2. Accessing the Multicam Web Setup

To access remotely a server desktop, proceed as follows:

1. Right-click on a server name, and select Web configuration from the contextual
menu.

A message appears to warn you that you are going to take control of the EVS server:

Warning, you are about to be able to change the configuration of the
- I_l server, Are you sure?

2. Click OK to open the server screen.
The Multicam Web Setup window opens.

Refer to the EVS Server Configuration manuals for more information.
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4.2.3. Accessing Remotely an LSM Remote Panel

Important
This function must only be used for training purposes. It is not intended to be
used for operations.

1.

2.
3.

4.

To connect to and take control of an LSM Remote connected to a server, proceed as
follows:

Right-click on a server name and select LSM Remote from the contextual menu.

In the following window, select the port number linked to the physical remote device:

XT_ADL: 'SM Remote Port Selection |:||§||X|

| Another instance of LSM remote iz already uging Remaote 1

Available Portz: | Remate 1 b |

1]4 [ Refresh ]L Cancel J

Clicking OK opens an interactive window representing the LSM remote panel and from
which you can use the different commands, such as on the physical remote itself.

You can close this window by pressing Escape.
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4.2.4. Rebooting an EVS Server

To remotely reboot a server, right-click on it in the Monitored Device Tree and select
Reboot in the contextual menu.

The Server Reboot message window is displayed. You must confirm the reboot process
to start it on the remote host.

NOTE

This command will be available only if the corresponding parameter is enabled
in the Settings window.

4.3. Uploading a Keyword File on an EVS
Server

To upload a keyword file on one or several servers, proceed as follows:

1. Inthe Tools menu, select Server > Keyword Files. The Keywords window appears.

= []#Met
=[] Discovered Hosts K eword file: D
[I=T_ADL
HT2_PGE

2. Select the server(s) to receive the keyword file in the left pane of the Keywords
window.
In the Keyword File field, browse your computer to select the keyword file to upload.

Click on the Upload button to start the keyword file copy on all selected servers.
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4.4,

Server Logs Extraction

To remotely recover the SNMP logs stored on a server, right-click on it in the Monitored
Device Tree and select Extract logs in the contextual menu.

The following warning message window is displayed to warn you that the extraction
process may interfere with the video diffusion from that server. Launch the extraction
process again later if you cannot accept any diffusion trouble at this time.

Logs extraction

|| E The log extraction process may affect the diffusion on serwver Server 2, Are wou sure vou want to proceed?
-

I es ] [ Mo l

The next window displays progress bars of the extraction and the current directory and file
being downloaded.

Logs Extraction from Server 2 |Z||E|rz|

Directary /ACALSMCE/DATAADGS

Downloading hardware. log

[= ]

Cancel

Once the logs extraction is done, a window briefly appears about the log files compression
then the Logs Extraction window displays the zip file name and its storing folder and path.

Logs Extraction

-
- | ) Logs files successfully extracted for Server 2, Available under C:\Program Files\EVS Broadcast EquipmentxMet Monitor\Downloaded logsi29100.zip

The different logged information (configuration, alerts...) is stored in different folders and
files and packed together in a zip file. Next to the zip files is a text file (LogExtracion_
servername.log) for each server that logs the extractions dates, operations, results and
resulting zip file.

NOTE

At log extraction, the log file on the remote server is closed and transferred.
After this operation, a new log file is created on the remote server to log the
events that happen from now on.
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